


СканКромсатор v5.93 Пособие по программе 

Неофициальная версия. Составил monday2000 на основании объяснений автора программы, 

собранных на известных форумах (c неоценимой помощью Arcand и других), и на основании опыта 

использования программы.Вследствие всего этого возможны ошибки и неточности. 

ВАЖНО: В Пособии даѐтся описание только таких элементов управления программы, про ко-

торые точно известно, для чего они и как они работают. В основном приводится описание наиболее 

необходимых и популярных возможностей программы. В отдельных случаях некоторые возможно-

сти программы не описаны умышленно - если они плохо работают, или же малопопулярны, и т.п. 

Актуального и официального хелпа к программе СканКромсатор от автора программы (bolega) пока не существует 

и ожидается в будущей (6-ой) версии программы.  
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1 Основной интерфейс программы 

1.1 Управляющие Tab-вкладки  

1.1.1 Вкладка Pages 

 

Элемент Описание 

Split 

Разделить страницу - Эта опция включа-

ет/выключает действие резака "Set internal margin or 

split line". Применяется для разрезания сдвоенных 

разворотов, или же для отрезания вертикальной по-

лосы - ошмѐтка соседней страницы - в случае оди-

ночного скана. 

Deskew 

Автоматическое устранение перекоса. Реко-

мендуется всегда использовать этот режим при са-

мой первой обработке сканов. Алгоритм - Hough 

transform с точностью 0.1. 

Despeckle 

Автоматическое удаление соринок. Работает 

только на чѐрно-белых сканах - а на серых и цветных 

не даѐт никакого эффекта - это особенность самого 

алгоритма. Не рекомендуется к использованию на 

ч.б. сканах плохого качества - может удалить участки 

букв или грамматические точки. 

Art 

Доп. режим работы Deskew - для страниц со 

сложными художественными рисунками, таблицами 

и сильно разреженных cтраниц. Применяйте в случа-

ях, когда обычный Deskew неправильно определяет 

угол перекоса страницы. 

Если же и при включѐнном Art угол перекоса стра-

ницы определяется неправильно - тогда нужно за-

ключить присутствующие на скане картинки или 

таблицы в Exclude-зону - чтобы исключить их из 

расчѐта угла перекоса. 

Art имеет один недостаток - выполняется в два-три 

раза медленнее стандартного алгоритма. Поэтому не 

стоит применять его для всех страниц подряд. 

Orhto 

Доп. режим работы Deskew - для страниц, со-

держимое которых расположено перпендикулярно, 

т.е. развѐрнуто на 90 градусов. Допускается исполь-

зовать одновременно с Art. 

Automargins 

Распознавающий режим резаков Эта опция 

должна быть всегда включена. Точное еѐ назначение 

неизвестно. 



Page h.align 

Горизонтальное автоматическое выравнивание 

текста по площади скана. Может принимать значе-

ния: A (Auto) - в действительности это Лево; L (Left) 

- Лево; C (Center) - Центр; R (Right) - Право. 

Page v.align 

Вертикальное автоматическое выравнивание 

текста по площади скана. Может принимать значе-

ния: A (Auto) - в действительности это Верх; T (Top) 

- Верх; C (Center) - Центр; B (Bottom) - Низ. 

  

 

Если приглядеться, то видно, что на этом рисунке все пронумерован-

ные элементы управления построены (автором программы) в 2 колонки - 

обозначенные буквами L и R. Это подопции левой (L) и правой (R) стра-

ниц. Понятия "левая" и "правая" страницы имеют смысл только при обра-

ботке сдвоенного разворота - когда одновременно с разрезанием обраба-

тываются образовавшиеся левая и правая половинки разворота. Активно-

стью элементов в колонке R управляет галка Split - когда она включена, то 

все элементы в колонке R становятся активными - и наоборот. В случае 

одиночного разворота (т.е. когда ничего не нужно разрезать) этот одиноч-

ный разворот условно считается левой страницей. Итак, в колонке L нахо-

дятся элементы с номерами 1, 3, 5, 7, 8, 11, 12, 15, 17; а колонке R - эле-

менты с номерами 2, 4, 6, 9, 10, 13, 14, 16, 18. 

Элемент № 7 Вкл./выкл режима распознавания контура текста у резака "Cut left margin". 

Элемент № 8 
Вкл./выкл режима распознавания контура текста у резака "Cut right 

margin". 

Элемент № 11 (T) (Top) Вкл./выкл режима распознавания контура текста у резака "Cut top margin". 

Элемент № 12 (B) 

(Bottom) 

Вкл./выкл режима распознавания контура текста у резака "Cut bottom 

margin". 

Обычно галки 7, 8, 11, 12 должны быть включены. Они управляют т.н. "режимом распознавания   

контура текста" у соответствующих резаков - верхнего, нижнего, левого и правого (при наведении 

мыши на ползунок каждого резака выдаѐтся контекстная подсказка с его названием). При включении 

этих галок соотвествующие резаки принимают синий цвет, а при выключении - малиновый.  

При синем резаке соответствующая сторона (левая, правая, верхняя, нижняя) контура текста на 

скане определяется автоматически - при последующей обработке по кнопке Process!. При малиновом 

резаке эта сторона задаѐтся вручную - самим положением резака. Т.е. малиновый резак режет "там, где 

стоит", а синий - лишь примерно задаѐт границу области распознавания контура текста, а программа 

потом сама при обработке определит истинную линию реза. 

Сначала существовали только синие резаки. Но из-за неизбежных погрешностей алгоритма рас-

познавания пришлось ввести малиновые резаки - чтобы устанавливать линию реза просто вручную - в 

сложных случаях, когда синие резаки неправильно срабатывают - отрезают полезные элементы текста. 

Наиболее часто это отдельно стоящие номера страниц и т.п. 

 



1.1.2 Вкладка Book 

 

Элемент Описание 

Units Используйте всегда значение Pixels. 

H.Gap val-

ue 

Размеры левого и правого полей, которые будут автоматически 

добавлены к контуру текста,  

определяемого программой (всѐ это происходит при обработке 

по кнопке Process!). Очень важный параметр,  

различный для разных dpi. Для 300 dpi следует задавать 70, для 

400 dpi - 100, для 600 dpi - от 120 до 150. 

V.Gap val-

ue 
Аналогично - здесь ширина верхнего/нижнего полей страницы. 

vert.gap = 

hor.gap 

Вкл./выкл. режим равенства вертикальных и горизонтальных 

полей. Рекомендуется всегда включать. 

Page width 

Способ определения ширины страниц при обработке по кнопке 

Process!.  

- Auto: Автоматическое определение средней ширины - самой 

обработкой по кнопке Process!.  

Рекомендованное значение. 

- Fixed: Обрезанная страница будет иметь заданные размеры, 

которые можно задавать вручную  

через предусмотренные справа поля. 

- None: Обрезанная страница не будет иметь полей - т.е. мы 

получим после обработки по кнопке  

Process! "голый текст" в чистом виде. 

Примечание: После обработки по кнопке Process!, если было 

задано Auto, программа автоматически  

подставляет вычисленные средние размеры страниц в поля 

H.Gap value и V.Gap value, и тогда нужно  

обязательно сменить Auto на Fixed, чтобы при повторной пере-

делке каких-то отдельных страниц  

(Process current file) их размер выдерживался равным вычис-

ленному. 

Page height Аналогично - способ определения высоты страниц. 

 

 

 

 

 

 

 

 

1.1.3 Вкладка Files 



 

Элемент Описание 

Output dir: 

Папка, в которую будут сохраняться результирующие 

файлы. Если папка не существует, программа попытается 

создать еѐ. 

Default 

Использовать папку по умолчанию для результирую-

щих файлов. Эта папка будет называться "out" и автоматиче-

ски создастся внутри папки с исходными файлами. 

Output prefix 

Произвольный префикс, который будет добавляться к 

именам выходных файлов. 

Можно задать символ * - тогда на выходе будут сохраняться 

оригинальные имена файлов. Если при этом исходные файлы 

являются multi-page тифами, или просто разворотами, то ис-

ходное имя также будет сохранено, но с прибавлением соот-

ветствующего суффикса. 

Start from/ 

step 

Start from (1) - числовое значение в имени файла, с ко-

торого начнется нумерация выходных страниц. 

step (2) - шаг, используемый при нумерации выходных фай-

лов. 

Name length Длина имени выходных файлов 

Output format: Формат выходных изображений. 

DPI Значение DPI выходных файлов. 

Color Режим цветности выходных файлов. 

Input DPI 

Входное dpi. Вводится только в том случае, если обра-

батываемые файлы либо не содержат значение dpi, либо оно 

у них неправильное. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1.1.4 Вкладка Options 



 

Элемент Описание 

Deskew 

method 

Выбор алгоритма поворота скана при Deskew. Рекомендуе-

мый метод - Auto(shear).  

Fast: Стандартный поворот. Именно этот режим использу-

ется в большинстве граф. программ. Это lossless-поворот, т.е. 

буквы не утолщаются. Но он приводит к артефактам: сдвигу од-

ной части буквы относительно другой и появлению эффекта "об-

ратного italic" (для сканов <= 300 dpi). Кстати, в BookRestorer эти 

артефакты налицо. Fast хорош для сканов с dpi > 500 - тогда ис-

кажения практически незаметны и его можно спокойно приме-

нять - к тому же он намного быстрее всех остальных режимов 

поворота. Начиная с версии 5.9, Fast больше не нужен. 

Antialias (англ. "сглаживание, устранение контурных не-

ровностей"): Для grey/color-сканов. Имеет интерполяцию для 

предотвращения артефактов (например, "ступеньки" в строках 

текста). Слегка неравномерно уширяет буквы. Для се-

рых/цветных Antialias полностью идентичен Interpolate, когда-то 

он был придуман именно для b/w чтобы нейтрализовать артефак-

ты. 

Interpolate: Для grey/color-сканов. Это Fast с билинейной 

интерполяцией - для предотвращения артефактов (например, 

"ступеньки" в строках текста). Хорош для gray и color, для b/w 

ничего особого не дает. На толщину повѐрнутого текста влияет 

значение параметра convert to b/w threshold (закладка Convert). 

Если выбрать Interpolate и задать Сonvert = LowLight, то ушире-

ние практически исчезает, при том, что текст поворачивается так 

же хорошо (т.е. не деформируется ступеньками), как и при 

Antialias-повороте. Начиная с версии 5.9, метод Interpolate пере-

писан на Ассемблере, поэтому работает быстрее, чем Fast. 

Shear (англ. "сдвиг ( фрагмента изображения )"): Метод для 

b/w-сканов. 

Auto(shear): Метод для b/w-сканов. Shear с автоматической 

компенсацией артефактов. Это не-интерполяционный метод. 

Данный метод - самый рекомендуемый. В отличие от Antialias, 

без побочных эффектов. Начиная с этой версии, при этом режиме 

grey/color-сканы поворачиваются с помощью метода Interpolate 

(наилучшее качество), а b/w - как и раньше, с помощью Shear-

метода. 

Вообщем, следует использовать только Auto(Shear), кото-

рый в зависимости от цветности скана сам выбирает нужный, 

наиболее оптимальный метод, т.е. Interpolate для серых-цветных, 

Shear c автокомпенсацией артефактов - для b/w. 



Antialias 

threshold 

Порог сглаживания. Регулирует работу режима Antialias 

(см. выше). Чем этот порог меньше, тем меньше утолщение, но 

тем больше проявление искажения. Рекомендуемое значение - 

150 - тогда буквы практически не утолщаются. 

Resample 

filter 

Фильтр при изменении разрешения (т.н. ресемплинг). 

Используйте всегда значение Bicubic. 

Despeckle 

Выбор алгоритма поворота скана при Despeckle. Рекомен-

дуемый метод - Normal. 

Примечание: любой из алгоритмов Despeckle предназначен только для ч.б. 

сканов - на grey/color-сканах он не производит никакого эффекта. 

ВАЖНО: Иногда Despeckle вообще не следует применять - на бледных или 

низкокачественных сканах - чтобы не удалить кусочки букв или грамматиче-

ские точки.  

Fine: Это "геометрический" алгоритм. Удаляются все спек-

лы, меньшие определѐнного размера (размер выбирается Кромса-

тором самостоятельно), и даже спеклы чуть большего размера, но 

имеющую определѐнную форму, явно указывающую на "мусор-

ное" происхождение. 

Распознаются буквы i и j и метод не позволяет "зачищать" их 

точки. Особенно это актуально, когда эти символы используются 

как индексы в математических формулах. Такой защиты, на-

сколько известно, нет ни в одной другой программе. Метод пока-

зал свою 100% эффективность и надежность. Это самый "чистя-

щий" метод. 

Normal: Это классический простейший алгоритм Despeckle 

(фильтр по среднему с апертурой 3х3 и с пропуском белых то-

чек). 

Fine+Normal: Интеллектуальный метод очистки. Напри-

мер, он не вычищает точки над i и j. 

Safe: Метод для бледных сканов, с разорванными буквами. 

В этом случае в процессе обработки области, занимаемые буква-

ми, чиститься не будут. Суть его - в предварительной кластери-

зации текста, т.е. выделении букв, и удалении мусора только в 

области, не принадлежащей букве. Метод не идеальный, но бук-

вы страдают гораздо меньше. 

Sand 

despeckle 

Эта опция хоть как-то соединяет точки "песочно-образных" 

букв (т.е. состоящих из разрозненных точек). 



Strong con. 

speckles 

Это strong connected pixels (4-connected pixels). В противо-

положность 8-connected pixels. Т.е. если эту опцию включить, то 

пикселы, касающиеся друг друга только по диагонали, будут ин-

терпретироваться как два разных, т. е. изолированных.  

Эта опция влияет на чистку. По умолчанию выключена, что 

означает: если пиксел касается другого только по диагонали, то 

они все равно считаются принадлежащими одному спеклу, и раз-

мер его получается больше, и вероятность его удаления понизит-

ся. Поэтому лучше не включать этот флаг. 

 

1.1.5 Вкладка Options 2 

 

Элемент Описание 

Cutters 

state: 

Управление режимом очистки резаков. Значение по-

умолчанию - cut&clear t/b, но рекомендуемое значение - only cut. 

Влияет также на вид галок панели управления резаками:  

 

cut&clear t/b: выключѐн/включѐн и засерен/включѐн (только 

резаки "верх-низ"). 

only cut: только включѐн/выключѐн. 

cut&clear all: выключѐн/включѐн и засерен/включен (все резаки). 

Засерен означает, что область за резаком будет не отрезаться 

при кромсании, а только очищаться. При включѐнном Automargins 

это даѐт в итоге один и тот же результат. Если же юзер взял весь 

контроль за размерами страниц на выходе на себя (Automargins = 

off), то это имеет смысл. 

Text vert. 

sensivity 

Вертикальная регулировка точности работы алгоритма, распо-

знавающего контур текста (т.е. алгоритм по кнопке Process!) Изме-

нять этот параметр НЕ рекомендуется никогда.  

При автоматическом определении программой контура текста могут воз-

никать неточности. Так, могут быть проигнорированы одинокие, далеко отстоя-

щие от основного текста символы ("одиночные выступающие  символы" (термин 

bolega) - ОВ-символы), напр. номера страниц, состоящие из одной цифры. Или 

последние 1-2 символа выступающей строки текста. Это известная и пока не ре-

шѐнная проблема. В результате эти символы могут быть потеряны (если их не 

перекроет задаваемое поле H.Gap Value или V.Gap Value). 

Рекомендуемый способ регулировки: после проработки Draft 

kromsate переключить в Automargins соответствующий резак с 

синего на малиновый и выставить его вручную сразу за ОВ-

символом, который некорректно отрезается алгоритмом по кнопке 

Process!. 



Text ho-

riz. sen-

sivity 

То же самое, что и строкою выше, только по горизонтали. 

 

1.1.6 Вкладка Convert 

 

Элемент Описание 

Convert to 

b/w thre-

shold: 

Порог конвертации в ч./б. Рекомендуемое значение - 

Normal. Влияет на процедуру конвертации grey->b/w Параметр 

определяет порог grey-цвета, ниже которого точка становится 

черной, а выше - белой. Диапазон 0-255. Для удобства ряд ходо-

вых порогов имеют имена (см. ниже). Это странично-

ориентированный параметр, т.е. для каждой страницы его мож-

но задавать различным.  

Влияет на результат, как это ни странно, при обработке цветных ска-

нов (без перевода в b/w). Можно его поварьировать (сделать более dark, если 

скан бледный, и light, если наоборот). 

The same 

for left & 

right 

Одно и то же для левого и правого (Вкл./Выкл.) Имеет 

смысл только при работе со сдвоенными разворотами. 



   

Left page: 

Значение порога конвертации для левой страницы. Подби-

рается экспериментально в зависимости от степени бледности 

скана. Неправильно выбранный порог приводит либо к потере 

деталей, либо к излишнему замусорению скана.  

Normal, LowDark, MiddleDark, LowLight, MiddleLight, 

HighLight: обычные ходовые пороги. 

HighDark: В отличие от остальных, не является пороговым. Он 

адаптивный, порог высчитывает автоматически, исходя из эн-

тропии изображения. 

Smooth: Исключение. Применяется спец.алгоритм со сглажива-

нием (анализирует энтропию), никак не связанный с порогом 

конвертации в b/w. Может сглаживать, "округлять" (слегка 

ужирнять) буквы (в т.ч. очень бледные части букв) и даже уве-

личивать их связность (убирать разрывы в буквах). 

Smooth очень хорошо работает на чрезвычайно блѐклых сканах или 

сканах поганого качества (например, с очень низким dpi). 

Недостаток - очень чувствителен к фону (шумам), поэтому если скан сильно 

грязный (с неравномерным фоном), то smooth вносит очень много мусора, 

который в итоге так сливается с текстом, так что никакой Despeckle потом не 

помогает, поэтому лучше использовать его совместно с Histogram 

Thresholding для подавления грязи (фон слегка забледняется с помощью 

Histogram, и поэтому не вносит мусора при конвертации). 

Серые полутоновые рисунки при Smooth следует включать в Exclude region. 

После Smooth текст слегка жирнеет. Чтобы этого не происходило, можно, к 

примеру, на закладке Quality -> Gray enhance... -> Contrast сдвинуть ползунок 

Brightnes (яркость) на позицию 20 влево. 

User: Значение порога задаѐтся пользователем. При выбо-

ре User появляются окошки выбора значения порога: 

 

Right page: 
Значение порога конвертации для правой страницы  

Аналогично - для правой страницы. 

 

 

 

 

 

 

 

 

 

 

1.2 Общие элементы 



1.2.1 Элементы управления списка файлов 

Элемент Описание 

 

Жирная зелѐная галочка (другое название - "marked"-файл). Еѐ смысл:  

1. Пометка на обработку (по кнопке Process!) данного файла - это сей-

час основной смысл. Только те файлы, напротив которых стоит эта галка, 

будут обработаны после нажатия кнопки Process!. 

2. Запоминание (для последующей обработки по кнопке Process!) те-

кущих изменѐнных индивидуальных настроек файла - уже устаревший смысл 

(из-за кнопки "Auto-accept options is on/off"). 

Когда-то после изменения опций (например, подвинули резак) необходимо было "пе-

рещѐлкнуть" эту галочку - т.е. снять еѐ и вновь поставить - иначе изменѐнные опции не запо-

минались, но в последних версиях Кромсатора появилась специальная (для этой проблемы) 

кнопка "Auto-accept options is on/off" - когда она включена, "перещѐлкивать" галочки 

(после изменения опций) уже не надо. Эта кнопка теперь включена по умолчанию. 

 

Щѐлкнуть мышкой на любой (обычно последний) файл в списке, на-

жать эту кнопку - автоматически проставятся жирные зелѐные галочки на 

всех файлах в списке, предшествующих ему. 

 

Щѐлкнуть мышкой на любой файл в списке, нажать эту кнопку - на нѐм 

проставится жирная зелѐная галочка. 

 

Щѐлкнуть мышкой на любой (обычно (пред)последний) файл в списке, 

нажать эту кнопку - автоматически проставятся жирные зелѐные галочки на 

всех alternate ("чередующихся", т.е. одинаковой чѐтности) файлах в списке, 

предшествующих ему. Т.е. если стоим на чѐтном файле - пометятся все пре-

дыдущие ему чѐтные файлы, если стоим на нечѐтном - то пометятся все не-

чѐтные. 

1.2.2 Виды выделений файлов в списке: 

Название Описание Способ выделения Групповое 

изменение 

Marked 
С жирной зелѐной 

галочкой 
Левая кнопка мыши Клавиша Ctrl 

Selected 
Выделенные красным 

цветом. 

Клавиша Пробел (или Insert) (при активном 

списке файлов).  

Чтобы выделить группу, нужно пробелом отме-

тить первый файл в группе, затем стать на по-

следний файл и нажать Shift + Пробел. 

Клавиша Shift 

Bold se-

lected 

Выделенные чѐрным 

жирным. 
Клавиша Ctrl + Пробел.  

Из таблицы видно, что, чтобы поменять опцию у группы файлов, то нужно (при изменении оп-

ции): 

- Для marked-файлов держать нажатым Ctrl. 



- Для selected-файлов держать нажатым Shift. 

Выделение Marked (как это указано чуть выше) используется, чтобы пометить файлы, которые 

будут обрабатываться обработкой по кнопке Process! 

Выделение Selected - это пользовательское выделение, используемое в случаях, когда нужно 

выделить группу файлов в списке и проделать над ней некую операцию. 

Выделение Bold selected используется обработкой Draft kromsate - для того, чтобы обозначить 

те файлы, где хотя бы один из резаков (после Draft kromsate) установился малиновым, а не синим. 

1.2.3 Групповое изменение опций 

Любую опцию можно установить/сбросить/изменить у любой группы файлов. Для этого нужно 

при изменении опции держать нажатым Alt. Кромсатор предложит на выбор, к какой группе приме-

нить изменение (в любом случае, выдав сначала такое предупреждение): 

 

 

1.2.4 Управление списком файлов 

1.2.4.1 Перемещение файлов: 

а. Единственный файл - нажимаем на него левой кнопкой мыши и перетаскиваемо на другую 

позицию в списке. 

б. Группа файлов: 

- Команда Move selected: перемещает все выделенные (selected) файлы (выделение может быть 

не обязательно сплошным, а, например, через один) в определѐнную позицию в списке файлов. На-

пример, можно выделить все чѐтные страницы и переместить их в конец списка, где они расположат-

ся уже последовательно. 

- Команда Shift selected: все выделенные файлы сдвигаются на заданное количество строк 

вверх или вниз, сохраняя при этом расстояние между друг другом. 

- Команда Paste interliev ("вставлять файлы через один"): вставляет в список (скопированные в 

буфер файлы) через один, т.е. на место только чѐтных или только нечѐтных. 

Если изменение порядка (как для единственного файла, так и для группы) выполняется уже по-

сле обработки по кнопке Process! (т.е. когда уже получены выходные файлы), то программа будет 

автоматически переименовывать и выходные файлы так, чтобы сквозная нумерация на выходе не 

нарушалась. 

1.2.4.2 Навигация по списку файлов: 

ВАЖНО: Для перемещения по списку файлов (в главном окне, а также в окне просмотра ре-

зультатов), можно использовать "горячие клавиши": "q" или "[" (предыдущий) и "]" или "w" (сле-

дующий). 

В списке исходных файлов нажатие стрелок, Home, End при нажатом Shift перемещают курсор 



на следующий selected, предыдущий selected, первый selected, последний selected соответственно. 

1.2.4.3 Многостраничные TIF-файлы: 

Если открывать много TIF-файлов скопом, программа считает их одностраничными. 

Если к первому открытому одностраничному TIF-файлу добавить многостраничные, она их то-

же считает одностраничными. 

Если первый многостраничный - то все нормально, т.е. программа распознаѐт корректно все по-

следующие добавленные файлы, какие бы (одно- или много- страничные) они ни были. 

Для того, чтобы открыть несколько (не один) TIF-файлов как многостраничные, нужно при вы-

боре команды меню (или при щелчке на кнопке открытия файлов) держать нажатым Shift. Такое яв-

ное указание было введено из-за чрезмерной длительности автоматического определения "много-

страничности" открываемых TIF-файлов. 

1.2.4.4 Разное: 

Начиная с 4-й версии, Кромсатор поддерживает полуавтоматическое добавление файлов в зада-

ние. Например, вы сканируете книгу, и файлы попадают в папку MyScan. Вы загружаете сколько есть 

файлов в задание. В дальнейшем, если в этой папке будут появляться от сканера новые изображения, 

можно просто нажимать в кромсаторе "H" (раньше для этого нужно было вызывать пункт меню add 

files) и они добавятся в конец задания (при условии, что сканирующая программма нумерует их). 

В уже существующее задание можно добавлять новые файлы (с возможностью пересортировки, 

если необходимо), при этом допускаются одинаковые имена файлов (при условии, что папки у них 

все-таки разные). 

Теперь в задании можно использовать любую смесь форматов файлов. (Ранее к multi-page-

тифам, например, нельзя было добавить bmp или jpg). 

1.2.5 Панель свойств загруженных файлов 

 

Элемент Описание 

1. 
<горизонтальный размер изображения в пикселях> х <верти-

кальный размер изображения в пикселях> 

2. 
<разрешение изображения в DPI>   <количество цветов изобра-

жения> 

3. <Вид сжатия изображения> 

При запуске Кромсатора эта панель ВСЕГДА не видна. Чтобы еѐ увидеть, надо "растянуть 

вверх" панель списка файлов. 

1.2.6 Кнопки панели управления 

- Общий вид основной панели управ-

ления. 

Эле

мент 
Описание 

 Load image files - загрузить графические файлы. 

 Save current task - cохранить текущее задание. 



 Fit image - растянуть изображение по ширине окна. 

 

Draft kromsate - т.е. запустить процедуру автоматической предварительной рас-

становки резаков - по всем загруженным сырым сканам. 

 

Запустить обработку marked-файлов (т.е. помеченных жирными зелѐными галоч-

ками). 

 Process current file - обработать текущий файл. 

 

Process left page - обработать текущую левую страницу. Имеет смысл только при 

обработке сдвоенных разворотов. 

 Process right page - аналогично для текущей правой страницы. 

Выкл.)  

(Вкл.) 

Auto-accept changings option - Автопринятие изменения опций  

Включена по умолчанию. Рекомендуется иметь эту кнопку всегда включѐнной. 

Выключать еѐ имеет смысл только при использовании кнопки Preview на вкладке 

Quality - т.к. при смене dpi кромсатор не корректирует положения резаков. 

 Image zoom - масштаб изображения. 

 

Rotate image - поворот изображения. Можно держать Ctrl или Alt при изменении 

значения в этом комбобоксе. Ctrl - повернет для всех, Alt - спросит, для каких. 

1.2.7 Схема расположения резаков 

 

(Изображение уменьшено) 

Элемент Описание 

1. - (Set internal 

margin) 
? 

2. - (Set internal 

margin or split 

line) 

Резак для разрезания 

сдвоенных разворотов 

3. - (Cut top mar-

gin) 
Верхний резак 

4. - (Cut left mar-

gin) 
Левый резак 

5. - (Cut bottom 

margin) 
Нижний резак 

6. - (Cut right mar-

gin) 
Правый резак 

 

1.2.8 Панель управления резаками 



- Общий вид панели управления резаками. 

При запуске Кромсатора эта панель ВСЕГДА не видна полностью. Чтобы еѐ увидеть, надо "за-

узить" панель списка файлов. 

 

Элемент Описание 

1.  (Cut left margin) Вкл./выкл. левый резак 

2.  (Cut right margin) Вкл./выкл. правый резак 

3. 

? (Возможно, это ранее было управление резаком для разрезания сдвоенных разво-

ротов, который теперь не отключается, а просто его действенность включает-

ся/выключается галкой Split) 

4.  (Cut internal2 margin) Вкл./выкл. резак Set internal margin (?) 

5.  (left cutter position) Координата левого резака 

6.  (first internal cutter position) Координата резака для разрезания сдвоенных разворотов 

7.  (right cutter position) Координата правого резака 

8.  (second internal cutter posi-

tion) 
Координата резака Set internal margin (?) 

9.  (Cut/clear top margin) Вкл./выкл. верхний резак 

10.  (Cut/clear bottom margin) Вкл./выкл. нижний резак 

11.  (top cutter position) Координата верхнего резака 

12.  (bottom cutter position) Координата нижнего резака 

13.  (left page width) 

Расстояние между левым и правым резаком (при выкл. Split) или меж-

ду левым резаком и резаком для разрезания сдвоенных разворотов 

(при вкл. Split) 

14.  (left page height) Расстояние между верхним и нижним резаком 

15.  (right page width) 
Расстояние между резаком для разрезания сдвоенных разворотов и 

правым резаком (при вкл. Split) 

16.  (right page height) Расстояние между верхним и нижним резаком 

 

1.2.9 Управление резаками 

Чтобы двигать сразу два резака синхронно (например, верхний и нижний), нужно держать на-

жатым Ctrl. 

Резаки можно наклонять (чтобы лучше отсекать грязь и полосы на перекошенных сканах). Для 

этого нужно двигать ползунок резака правой клавишей мыши, либо левой, но с нажатым Shift. Двой-

ной щелчок на ползунке выпрямляет резак. 

Если нужно убрать тень и мусор от разворота, но при этом не разрезать разворот на две части, 

то нужно убрать опцию Split, но оставить оба внутренних резака. В этом случае область между ними 



будет просто очищаться. 

Резаки синхронизируются с картинкой при изменении масштаба, повороте и отражении. 

Можно на панели управления резаками в контекстном меню элемента, в котором выводятся ко-

ординаты резаков (Xi1=..., Xi2=..., и т.п.) выбрать команду Reset cutter position - соответствующий 

резак подойдет к соответствующему краю страницы и станет виден. 

Отключение резаков скопом не предусмотрено (чревато). Но выход есть - нужно вывести резаки 

за пределы картинки. 

1.2.10 Контекстное меню ПОЛЗУНКА любого резака 

 

Элемент Описание 

Reset slope Убрать наклон резака (т.е. "выпрямить" его). 

Copy current position to   > 
Распространить позицию данного резака на ... Подробнее - см. 

ниже таблицу 

 

Copy current position to  Распространить позицию данного резака на ... 

Пункт меню Назначение 

all marked все файлы, отмеченные жирной зелѐной галочкой. 

all down все нижележащие файлы 

all up все вышележащие файлы 

alternate down все нижележащие файлы той же чѐтности 

all selected все выбранные красным файлы 

 

1.2.11 Пункты контекстного меню (главного окна) 

Редактировать теперь можно и исходное изображение (в отличие от старых версий), хотя опе-

раций и меньше, чем для выходного. Поддерживается редактирование для многостраничных тифов. 

Исходный файл можно чистить (Mouse-Up mode -> Clear selection) и сохранять (Auto save). 

Для исходного изображения имеется операция быстрого удаления любой тонкой сплошной 

длинной чѐрной линии (хорошо удалять подчѐркивания ручкой). Пока только для исходного b/w-

скана. Нажав Ctrl + Shift, щѐлкните по любой черной точке контура. Но учтите, что если линия каса-

ется буквы, то и буква удалится. 

При редактировании изображений (как исходного, так и выходного) поддерживаются не только 

прямоугольные выделения, но и эллиптические и произвольной формы, нарисованные мышкой. 



 

Пункт меню Назначение 

Zoom rectangle Увеличить выделенный фрагмент во весь экран 

Show selection 

По этой команде создаѐтся небольшое окошко (их можно создавать 

сколько угодно), в котором будет отображаться выделенная область. В 

нѐм можно таким образом "хранить" разные варианты обработки и ви-

зуально сравнивать их. 

Crop selection Вырезать выделенный фрагмент в отдельное новое изображение 

Invert selection 

Инвертировать выделение - поменять местами выделенную и не-

выделенную область - т.е. выделенная область становится не-

выделенной, а пространство скана за пределами этой области становит-

ся выделенным.  

Так можно, например, выделить на изображении области вне рисунков: 

выделяем картинки (множественное выделение поддерживается, дер-

жать shift), и выбираем команду invert selection - тогда выделение ин-

вертируется, т.е. выделяется все, кроме картинок. 

Deselect Снять выделение 

Save image Сохранить изображение 

Undo Откат изменения. Глубина отката - неограниченна 



Exclude region 

Зона исключения. Допускается до 20 зон на страницу. Исключает дей-

ствие (внутри зоны) следующих операций:  

Despeckle - для защиты полутоновых или мелкозернистых рисунков и 

изображений. Это первоочередная задача Exclude region. 

Deskew (Auto Shear, Interpolate, Antialias) - зона не будет участвовать в 

определении skew-угла (например, именно изображения приводят к 

неправильной детекции угла наклона). Зона будет поворачиваться без 

использования интерполяции, чтобы не внести дополнительный муар. 

Выравнивание освещенности - если на скане имеется полутоновые ил-

люстрации, то при  они могут сильно пострадать. 

Все опции Gray image enhance, за исключением Histogram. 

Метод удаления фона Convert -> Convert to b/w threshold: -> Smooth. 

Exclude and Mark as dither 

region 

Данная зона при обработке будет переводиться в b/w по специальному 

алгоритму, предназначенному для правильной передачи полутоновых 

или цветных изображений. 

Mark as bitonal region 
Bitonal-конвертирование зон. Просто спасение для точной передачи 

многотоновых иллюстраций. 

Mark as change contrast 

region 

Зона изменения контраста. Значение контраста берется из окошка 

Contrast, закладка Contrast, при условии, что применение изменения 

контраста глобально (ко всему изображению) отключено. Т.е. если на 

закладке Contrast стоит галка на Enabled, то contrast-zones игнорируют-

ся. 

Mark as floodfill region 

FloodFill-зоны работают только для b/w. Заливается белым цветом чѐр-

ная область, начиная от центра зоны. Если окажется, что в центре зоны 

- белый пиксел, то кромсатор будет искать черный пиксел в пределах 

зоны, начиная от центра и двигаясь по спирали. Если в пределах зоны 

не будет чѐрных пикселей, то ничего выполняться не будет. Заливка 

чѐрной области выполняется применительно ко всей области, т.е. не 

ограничивается размером зоны. Т.е. зона нужна только для того, чтобы 

задать своим центром начальную координату, с которой будет выпол-

няться заливка. 

Delete all regions Удалить все выделенные участки 

Delete selected region Удалить выделенный участок 



v   Ruler 

С его помощью можно мерить не только расстояния, но и одновремен-

но угол наклона. 

Запись измеренного угла: включить режим измерения углов (меню 

Ruler), щѐлкнуть на первой точке линии измерения и, не отпуская 

кнопку мышки, подвести еѐ курсор к другой точке этой же линии. За 

мышкой будет следовать "резиновая" линия, рядом с которой будет 

выводиться угол наклона линии. Если затем отпустить кнопку мыши и 

при этом держать нажатым Ctrl (или Shift), то измеренный угол зане-

сѐтся в поле Fixed deskew angle (вкладка Pages кнопка special...) с тем 

же знаком, что и знак, выдаваемый Ruler. На этот жѐстко заданный 

угол кромсатор и будет поворачивать скан при обработке. Кстати, все 

углы в кромсаторе трактуются одинаково, т.е. + означает поворот про-

тив часовой стрелки. 

Units                       > Единицы измерения 

No Zoom Filter 
Выключение фильтра отображения изображения. Это удобно при де-

лать при работе с цветными сканами - чтобы меньше тормозило. 

• Linear Zoom Filter Использовать линейный фильтр отображения изображения. 

Mouse-Up mode    > Выбор смысла прямоугольного выделения мышью см. далее подробнее 

Selection form        > Выбор формы инструмента выделения фрагмента см. далее подробнее 

v   AutoSave 
Автосохранение текущего файла при переходе к следующему. Удобно 

при редактировании каждой страницы. 

v   Do not show save dialog ? 

Convert to bitonal    Ctrl+Y 

Преобразовать в битональное изображение. То есть применить dithering 

(или растрирование) к серому изображению - т.к. его прямое преобра-

зование его в ч.б. испортит его. Dithering (дизеринг) - это имитация 

серого (8-битного) изображения мелкими чѐрно-белыми точками, по-

строенными на скане так, что dithering-изображение издалека очень 

похоже на исходное серое - однако, является уже 1-битным - т.е. чѐрно-

белым.  

Алгоритм работы с Convert to bitonal: страницы с худ.картинками ска-

нируем в grey, преобразуем иллюстрации (т.е. отдельные фрагменты 

страницы) в bitonal, нажимаем Preview (при этом т.к. выходной формат 

задан b/w, получаем исходный файл уже как b/w), сохраняем его и в 

итоге на входе программа уже имеет b/w-файл, но с иллюстрациями, 

почти не попорченными прямым конвертированием в b/w. Надо еще 

чтобы use error dithering был включен, там же, в меню. 

Convert to b/w        Ctrl+U 

Преобразовать в ч.б. При этом порог конвертации берется из текущего 

значения Convert to b/w threshold на закладке Convert). При этом фор-

мат файла не изменяется, просто заданный кусок преобразуется в b/w и 

возвращается на место, т.е. файл как был, так и остаѐтся 8-битным (се-

рым) - а преобразованная картинка построена теперь уже только лишь 



из чѐрного и белого цветов. 

Convert to grey 
Конвертирует выделенную область на цветном изображении в grey. 

Команда не является опцией обработки. 

 

 

Mouse-Up mode Выбор смысла прямоугольного выделения мышью 

Пункт меню Назначение 

v   Set exclude region Установить зону исключения 

Mark as dither region Пометить как dithering-зону 

Mark as change contrast 

region 
Пометить как зону изменения контраста 

Clear selection 

Очистить выделение. Это очень удобный режим для ручной чистки 

от мусора. Выделяем грязь прямоугольником мышью, отпускаем ле-

вую кнопку мыши - и весь выделенный прямоугольник очищается. 

Convert to b/w Конвертировать в чѐрно-белое 

Convert to bitonal Конвертировать в dithering 

1.3 Пункты меню 

ПРИМЕЧАНИЕ: В этом разделе будут рассмотрены только наиболее важные и интересные 

пункты меню. О смысле и значении остальных пунктов меню (которые мы не будем рассматривать) 

легко догадаться, исходя из прочих разделов данного Пособия. 

1.3.1 Пункт меню File 

В программе существует такое понятие, как "Задание". Задание - это информация о загружен-

ных в программу файлах, расставленных по ним резакам, выставленным опциям и т.д. Задание мож-

но сохранять и открывать заново. Использование задания позволяет прерывать и снова возобновлять 

обработку сканов 

Open task Открыть задание 

Save task Сохранить задание 

Close task Закрыть задание 

Task options settings Открыть окно выбора пакета опций 

1.3.1.1 Подпункт Task option settings 

Опции программы, изменѐнные пользователем, можно сохранять в виде набора, и потом ис-

пользовать повторно. 

Для этого в окне File->Task options settings задайте нужный набор опций, присвойте этому на-



бору любое имя и сохраните его (кнопка Save). Можно создать сколько угодно таких наборов default-

опций - со своими именами. Один из таких наборов будет набором по-умолчанию (поставите в нѐм 

галку на Use as default options) - он будет автоматически загружаться при открытии Кромсатора. 

Перед созданием нового задания можно загружать любой набор - тогда эти опции восстановят-

ся. После этого можно загружать новые изображения.   Например, можно сделать отдельные наборы 

для 300dpi, 600dpi, и т.д. 

 

1.3.2 Пункт меню Edit 

Clear all options 

Очистить все опции. Эта команда сбрасывает все опции программы в 

нулевые значения (причѐм, они не совпадают со значениями по-умолчанию). 

Очень удобно для нестандартных обработок. 

1.3.3 Пункт меню Result 

Result 

Пункт меню Назначение 

View all 

Открывает редактор постобработки, если в Кромсаторе имеются фай-

лы, прошедшие обработку, то есть выполняются условия:  

1. В списке файлов есть хотя бы один marked-файл. 2. Существует пап-

ка для выходных файлов. 3. В этой папке есть хотя бы один файл, соответ-

ствующий какому-либо marked-файлу (он и загрузится в редактор постооб-

работки). 

Информацию о файлах, прошедших обработку, можно сохранить в 

файл задания (меню File -> Save task) и затем загрузить еѐ обратно в про-



грамму (меню File -> Open task). После этого можно опять открыть редактор 

постобработки (выбрав View all) и продолжить там обработку выходных 

файлов. 

Show source files 
Возможность в окне просмотра результата редактировать исходные 

файлы. 

2 Интерфейс редактора постобработки 

2.1 Общие элементы 

Общий вид панели управления редактора постобработки: 

 

Обе панельки инструментов - плавающие, их можно пристыковать к бокам или превратить в 

окошки и закрыть (Right click - Hide) - чтобы увеличить "эффективный" размер экрана. Для того, 

чтобы опять включить их, надо выбрать в контекстном меню Options... -> Show navigate command's 

panel и/или Show edit command's panel. 

Элемент Описание 

- First page Перейти к первой странице 

- Previous page Перейти к предыдущей странице 

- Next page Перейти к следующей странице 

- Last page Перейти к последней странице 

- Fit Сделать масштаб "по ширине страницы" 

- Sync original scan with cur-

rent image 

Если включить опцию “Sync”, то при навигации по выходным фай-

лам будет производиться автоматическая смена изображений и в 

окне с исходными файлами. 

 

- Image zoom 
Регулировка масштаба 

 

- Page number 
Переход к странице с нужным номером 

 

- Panels layout 
Режим отображения страниц 

- Shift image increment 

value 

- Можно двигать изображение клавишами "Alt + стрелка". Здесь за-

даѐтся шаг смещения. 

- Copy Копировать 

- Cut Вырезать 

- Paste Вклеить 

- Undo Отменить 

- Auto-clear mode Режим автоочистки 



- Auto-despeckle mode Режим автоудаления соринок 

- Eraser Ластик 

- Crop Вырезающий прямоугольник 

- Show stamp Показать штамп 

- Clear options Показать диалог с опциями очистки 

- Rotate selection Показать диалог вращения выделенного фрмагмента 

Чтобы пометить файл (как selected, т.е. красным) в списке файлов основного окна, находясь при 

этом в окне редактора постобработки Result view, нужно нажать F2 или F2 и F3 (для левого и право-

го файла, в случае, если в окне просматриваются сразу два выходных файла). Это бывает необходи-

мо, чтобы отметить неправильно обработанный файл. Пометив таким образом все (или один) такие 

файлы, можно вернуться в главное окно Кромсатора, подправить помеченные файлы и дать команду 

process selected. 

Во окне Result view нажатие Backspace перемещает на предыдущую просмотренную страницу 

(например, смотрели 10-ую, потом 15-ую - нажали Backspace и вернулись к 10-ой, а не к 14-ой). Ctrl + 

Backspace - на страницу, с которой началось просматривание в окне Result view. 

Форму выделения можно запомнить в буфер обмена (Ctrl-Insert), потом восстановить - на этом 

же, или на другом файле (Shift-Insert). 

Может ли Кромсатор делать despeckle для белых точек на чѐрном фоне? Да, но только в окне 

редактора постобработки Result view (т.е. в основном окне программы не может). 

Для листания страниц используются следующие "горячие клавиши": вперед - w и ], назад - q и [. 

Листает также нажатие средней кнопки мыши. В последнем случае направление листания можно 

задать, выбрав соответствующую опцию в контекстном меню Options... -> Middle button click -> 

(Forward, Backward, None). 

Ctrl-Shift-щелчок мыши на b/w работает как floodfill, на grey/color - как magic wand. 

Hotkey: в случае, если zoom таков, что изображение не вмещается целиком в окно просмотра, 

"A" или ":" делают видимым верхнюю часть изображения, а "S" или """ - нижнюю, т.е. быстрый 

скролл вверх-вниз. 

В версии 5.6A почти все операции редактирования доступны во всех режимах просмотра (оди-

ночная страница/две страницы/сравнение с оригиналом). Активное окно подсвечивается. 

Некоторые возможности редактора постобработки:  

Ластик, стирающий одним из трех цветов: белым, чѐрным, или средним по заданной области 

(это для цветных и серых).  

На страницу можно поместить штамп (с поддержкой прозрачности), двигать его мышкой, из-

менять размеры, и затем слить с изображением.  

Magic-wand, усреднение цвета и т.д.  

Возможность применить despeckle не ко всему тифу, а к выделенному участку. Причем имеется 

и white-despeckle, когда убираются не черные точки, а наоборот - белые на чѐрном фоне.  

При редактировании изображений (как исходного, так и выходного) поддерживаются не только 

прямоугольные выделения, но и эллиптические и произвольной формы, нарисованные мышкой.  

В выходном изображении поддерживаются Copy, Cut, Paste, Paste c прозрачностью.  

В clipboard можно Copy не только из СканКромсатора, но и из любых графических программ.  

После Paste фрагмент можно двигать, растягивать и только потом merge.  



Поворот выделенной области.  

Масштаб клавиатурой через (+,-).  

2.2 Пункты контекстного меню 

2.2.1 Общее контекстное меню 

 

 

Пункт меню Назначение 

Special...    > Специальные возможности 

Clear Очистить выделение 

Crop Вырезать выделение в отдельный файл 

Rotate selection  

Ctrl+R 

Поворот выделения. Rotate selection нельзя пользоваться в режиме показа Two 

pages. Просто в этом случае не всегда понятно, к какому из двух изображений 

применять команду. Сейчас в принципе это можно определить по тому, где 

вызвано контекстное меню, но когда будет общее меню и плавающая панель 

инструментов - тогда проблема. 

Stamp    > Работа со штампом 

Undo    Ctrl+Z Безлимитный 

Save Сохранить 

Image info    Ctrl+I Информация об изображении 



Options...    > Подменю с опциями 

Zoom rectan-

gle  Ctrl+W 
Увеличить выделенный прямоугольник во всѐ окно 

Fit    Ctrl+F Сделать масштаб по ширине окна 

Fit height    Ctrl+H Сделать масштаб по высота скана окна 

Copy    Ctrl+Ins 
В clipboard можно Copy не только из кромсатора, но и из любых графических 

программ 

Cut    Ctrl+X Вырезать 

Move    Ctrl+M Двигать 

Shift image Сместить изображение 

Paste    Shift+Ins 

После Paste фрагмент можно двигать, растягивать и только потом merge.  

Выделяем, Copy. Paste - участок появится поверху страницы и он ещѐ не слит с 

ней, т.е. его можно таскать или изменять размеры. Если же ещѐ нажать клави-

шу T (разницу почувствуете сразу же после нажатия), то последущий merge 

будет выполнен с прозрачностью, т.е. белый цвет будет прозрачным. Для того, 

чтобы окончательно слить участок с изображением, выбираете команду merge 

в контекстном меню или щелкаете в любом месте за пределами участка. В но-

вой версии добавлена ещѐ возможность сделать прямоугольнички по краям 

участка (grips) однопиксельными, а то при копировании малых участков эти 

грипы все заслоняли. 

Invert selection Обратить выделение 

Deselect Убрать выделение 

v   AutoSave Автоматическое сохранение данного файла при переходе к последующему. 

v   AutoClear 
После взвода AutoClear выделения мышкой будут чиститься автоматически, в 

момент отпускания клавиши мыши. 

Clear options Опции очистки 

Clean color    > Цвет, которым будет закрашиваться очищаемая область 

Convert to bitonal Конвертировать в dithering 

Convert to b/w Конвертировать в чѐрно-белое 

Draw    > Вызов подменю рисования 



Restore last selections 

Начиная с версии 5.05, в Кромсаторе есть одна хитрая возможность - предпо-

ложим, что вы почистили (в режиме autoclear) изображение и вдруг обнаружи-

ли, что по каким-то причинам страницу нужно пере-обработать (иногда такое 

бывает: обнаруживаешь, что часть страницы была блеклая и despeckle эту 

часть повредил). Тогда заключаете эту часть страницы в exclude-зону, которую 

despeckle трогать не будет, переобрабатываете страницу, и чтобы не чистить 

страницу по новой, выбираете команду restore last selections и нажимаете 

Delete. В результате команда отселектирует все зоны, которые были зачищены 

при предыдущей обработке, и по нажатию del очистит их.  

Если же при ручной чистке использовалось despeckle-removing (с помощью 

Ctrl-Mouse Up), то такие зоны тоже передеспеклятся (в таком же режиме) ав-

томатом, а на странице выделятся желтой подсветкой, аналогично и для слу-

чая, если имело место despeckle белых пятен на чѐрном фоне (Ctl-Shift-

MouseUp), только подсветка будет зеленой. 

Text label    > Работа с текстовой пометкой 

2.2.2 Очистка сканов от грязи при помощи мыши 

Любой из возможных алгоритмов Despeckle не в состоянии полностью и автоматически очи-

стить скан от соринок, грязи, мусора, и т.п. Поэтому иногда следует вручную почистить сканы после 

Despeckle (а иногда и вместо Despeckle - если сканы бледные, плохо пропечатанные - и Despeckle 

может их попортить). 

Настройка:  

включаем в контекстном меню AutoSave (чтобы не надоедал сообщениями о необходимости 

сохранять изменѐнный файл).  

включаем в контекстном меню AutoClear (теперь после выделения в момент отпускания мыш-

ки будет производиться чистка/деспеклирование, какие - см. дальше).  

в окне Clear options (см. чуть ниже) задаем Speckle size (fine) = 20.  

Чистка: 

а. Простая очистка: 

Выделяем фрагмент, в момент конца выделения, когда кнопка мышки отпускается, выделенный 

фрагмент полностью очищается. Цвет, которым заливается, зависит от опции Clean color 

(white/black). Цвет можно также быстро изменить просто двойным щелчком мышки на изображении. 

б. Despeckle-очистка: (рекомендуемая) 

Если при этом держать нажатым Shift, то будет не очистка, а despeckle (обращаю внимание, что 

despeckle применяется не ко всему изображению, а только к выделенной области). Следует увеличить 

(см. ниже окно Clear options) допустимый Speckle size (рекомендуемое значение - Speckle size (fine) 

= 20), и тогда чистка будет намного лучше, чем просто Despeckle при обработке (по кнопке Process!), 

но нужно следить, чтобы выделение не захватывало знаков препинания. Режим хорош тем, что не 

нужно точно позиционировать выделение на мусор, можно захватывать и текст, он в большинстве 

случаев не пострадает. Таким образом, Despeckle-очистка гораздо менее трудоѐмка, чем простая очи-

стка, только самые большие кусочки мусора надо вычищать всѐ-таки простой очисткой (т.е. через 

Shift при Despeckle-очистке). 

Если при этом держать нажатым и Shift, и ещѐ Ctrl, то despeckle будет работать не для чѐрного 

мусора, а для белого, т.е. закрашивать мелкие белые пятна на чѐрном фоне. Если после этого остают-



ся пятна, которые больше, чем заданный Speckle size, то делаем двойной щелчок (т.е. переключаемся 

на заливку чѐрным), выделяем пятно, отпускаем мышку - пятно закрасилось. Снова двойной щелчок, 

чтобы вернуться к белой заливке. При despeckle белых пятен нужно быть осторожным с текстом - 

внутренние замкнутые полости ряда букв часто имеют малые размеры и могут при этом легко закра-

ситься чѐрным! 

 

Можно сделать немного по-другому: с самого 

начала в окне Clear options установить Change 

mode by mouse dbl-click = Clear/despeckle (чтобы 

двойным кликом быстро переключаться от чистки 

полной до чистки по типу despeckle).  

Вообще поведение клавиш (Shift, Ctrl) можно 

изменять - в окне Clear Options. Т.е. можно задать, 

чтобы при простом отпускании мыши был 

despeckle, а с Shift - чистка. Кому как нравится. По 

умолчанию используется Clear Options -> Des-

peckle method -> Fine. Можно дополнительно ука-

зать использовать Fine+Normal. Но размеры до-

пустимых спеклов для Normal (они задаются раз-

дельно, для Fine - одни (поле Speckle size (fine)), 

для Normal - другие (поле Speckle size (normal)) 

лучше не увеличивать. Т.к. Normal не просто чис-

тит мусор, но и убирает лохматинки с букв. 

  

 

Элемент Описание 

Speckle size 

(fine) 
Максимальный размер соринок, которые будут удаляться выделением мышью 

Action 

MouseUp - clear, Shift+MouseUp - despeckle 

MouseUp - despeckle, Shift+MouseUp - clear 

MouseUp - clear, CapsLock=On - MouseUp - despeckle  

Выбор режима очистки мышью 

Там ещѐ есть несколько операций с magic color. Это для цветных сканов (или для цветных ил-

люстраций). Штука сильная. Позволяет "выравнивать" цвет, делать как бы цветовой despeckle и сlean 

и т.п. Как это работает, объяснять долго, это будет описано в будущей доке. 

В Clear options сохраняется список цветов, использованных при magic clear (только в пределах 

сессии). 

2.2.3 Окно поворота выделенного фрагмента 



 

Rotate selection. (Поворот выделения). Работает для выделенного участка (можно всю страни-

цу). Тут можно задать угол поворота, либо расчитать его автоматом (кнопка auto 2), потом нажать 

Paste (положит обратно, но не сольѐт, т.е. можно будет подвигать мышкой) или Paste and merge (по-

ложит и сольѐт сразу). Сброс угла - кнопка 1, выбор направления поворота - в группе Rotate 

direction; можно выбрать алгоритм поворота в списке 3. Можно включить режим прозрачного нало-

жения Merge with transparency. Есть окошко предварительного просмотра 5, где можно щѐлкать 

мышью на картинке, и она будет увеличиваться (для возврата к исходному масштабу нажмите кнопку 

fit image 4), а ещѐ можно "схватить" и "таскать" картинку мышью в окне предварительного просмот-

ра. 

 

2.2.4 Контекстное подменю опций 

 

 



Options... 

Пункт меню Назначение 

• Mouse Wheel -> Zoom 
Включить режим, когда вращение колѐсика мыши изменяет 

масштаб 

Mouse Wheel -> Scroll 
Включить режим, когда вращение колѐсика мыши прокручивает 

скан 

MouseWheel -> Navigate Включить режим, когда вращение колѐсика мыши листает сканы 

Middle button click    > Выбор смысла работы средней кнопки мыши 

v  Auto merge ? 

No Zoom Filter Отключить фильтр отображения сканов 

• Linear Zoom Filter 

Включить линейный фильтр отображения сканов  

Одна страница 600dpi grey или color занимает в несжатом виде (а именно так 

windows работает с битмапами) от 50 до 100 МБ - именно из-за этого Кромса-

тор долго отображает такие сканы при включенном фильтре, ведь фильтр на 

каждую точку анализирует 9 соседних, т.е. умножьте объѐм ещѐ на 10. Нагруз-

ка на кэш процессора колоссальная. 

Nonlinear Zoom Filter Включить нелинейный фильтр отображения сканов 

v  No zoom filter for source 

images 

Если эта опция активна, в режиме "сравнение с оригиналом" ле-

вое изображение, т.е. оригинал, отображается без фильтра. 

v  Lock undo Возможность блокировки undo-менеджера. 

v  Remove text label after 

merge 
? 

v  Show navigate command's 

panel 
Показать плавающую кнопочную панель - Панель навигации 

v  Show edit command's panel 
Показать плавающую кнопочную панель - Панель редактиро-

вания 

Selection form    > 
Выбор формы выбирающего инструмента - прямоугольник или 

полигон 

3 Описание работы с программой 

При самом первом сеансе работы с Кромсатором убедитесь, что кнопка с галкой Auto-accept 

changings option is on/off (в верхней панели) включена и галка на ней имеет зелѐный цвет. Кнопка 

должна выглядеть вот так: . Это означает, что все изменения опций, которые Вы cделаете, будут 

фиксироваться автоматом. Иначе, как только Вы сместите фокус с файла, все выставленные Вами 

опции (например, позиции резаков) уйдут. 

Коротко алгоритм работы со СканКромсатором: 

(Это лишь концептуальное описание - для общего понимания сути работы с программой) 

Предварительная обработка 

Загружаем сырые сканы и разрезаем вручную (для полного визуального контроля над процес-

сом) сдвоенные развороты или же, если это одиночные сканы, отрезаем у каждого скана ошмѐток 



соседней страницы в виде вертикальной полосы. 

Это делается так: Выбираем в меню Edit -> Clear all options. Затем кликаем мышью последний 

файл в списке загруженных и нажимаем кнопку Apply up to current - от этого на 

всех файлах в списке проставятся жирные зелѐные галочки. Удерживая Ctrl, выставляем на вкладке 

Pages галку Split (разрезать сканы) и галку Deskew (чтобы применить Deskew ко всем получаемым в 

процессе разрезания сканам). Позиционируем резак Set internal margin or split line над линией смы-

кания 2-х соседних страниц на самом первом скане. Нажимаем правой кнопкой мыши на ползунок 

этого резака, и в появившемся контекстном меню выбираем пункт Copy current position to -> all 

down. Тем самым, данная позиция резака распространится на все нижележащие сканы. Теперь нужно 

пройти дальше по всем сканам - при помощи клавиатурных клавиш "q" и "w" (или "[" и "]") и вруч-

ную подкорректировать позицию разрезающего резака - чтобы она проходила над линией смыкания 

2-х соседних страниц на всех сканах. При необходимости повторяйте Copy current position to -> all 

down. 

Выставляем прочие нужные опции (Output dir и т.п.) и нажимаем кнопку Process!. Ждѐм, пока 

все сканы не разрежутся. 

Выходим из программы. 

3.1 Окончательная обработка 

Загружаем в программу полуобработанные после 1-го этапа сканы. Нажимаем кнопку Draft 

kromsate . В открывшемся окне нажимаем OK. Запустится процедура автоматической предвари-

тельной расстановки резаков - по всем загруженным сканам. 

После окончания работы Draft kromsate проходим вручную по всем сканам и корректируем 

неправильно выставившееся резаки. Принцип в том, что резаки не должны отсекать ничего полезно-

го, но в то же время они должны по максимуму отсекать всю грязь от текста. Некоторые резаки после 

Draft kromsate будут вообще отключены - тогда их можно включить (если нужно) на панели управ-

ления резаками - вот еѐ изображение: 

 

На разряженных страницы, где мало текста (титульные страницы, оглавления, страницы с вы-

ступающими одинокими строками и т.д.), Draft kromsate автоматически переключит некоторые ре-

заки с синего на малиновый - чтобы подчеркнуть место неуверенного распознавания контура текста. 

В списке файлов такой скан будет выделен чѐрным жирным цветом. Зачастую следует вручную под-

корректировать малиновые резаки (после Draft kromsate) и переключить их обратно на синий режим 

- для простоты. 

Если нужно - можно на данном этапе сохранить задание на диск (меню File -> Save task) и во-

зобновить работу позже. 

Выставляем на вкладках программы желаемые опции обработки (Despeckle и т.п., можно по-

вторно Deskew для надѐжности). 

Нажимаем кнопку Process! и ждѐм. Начинается автоматическая финальная обработка сканов 

(включая обрезку).  

После обработки (по кнопке Process!), переключаемся на вкладку Book. Программа автомати-

чески подставила вычисленные средние размеры страниц в поля H.Gap value и V.Gap value. Теперь 

нужно обязательно сменить там Auto на Fixed, чтобы при повторной переделке каких-то отдельных 

страниц (Process current file) их размер выдерживался равным среднему вычисленному. 



Если нужно - можно на данном этапе сохранить задание на диск (меню File -> Save task) и во-

зобновить работу позже. 

Просматриваем полученные сканы в редакторе постобработки (меню Result -> View all). Если 

мы замечаем, что где-то неправильно отрезался отдельно стоящий номер страницы, или же кусочек 

строки - возвращаемся в главное окно программы, становимся на нужный скан, и корректируем нуж-

ный резак. Как правило, нужно при этом переключить этот резак с синего на малиновый - путѐм 

сброса соответствующей галки в группе Automargins на вкладке Pages. Откорректировав резаки, 

нажимаем кнопку Process current file (обработать текущий файл) - и данный скан перенарежется 

по-новому. 

Вот и всѐ - таков вкратце алгоритм работы с программой. 

3.2 Что такое Draft kromsate: 

Draft kromsate - это автоматическая расстановка резаков самой программой, т.е. автоматизация 

самой нудной и рутинной работы. Draft kromsate - это т.н. алгоритм автоматической сегмента-

ции, т.е. определение логических блоков, занимаемых на скане полезным текстом и грязью. Задача 

Draft kromsate -  только расставить резаки на сканах (приблизительно), он не вычисляет размеров 

финальных страниц. 

3.3 Что такое кнопка Process! 

Основная обработка по кнопке Process! - это автоматический алгоритм распознавания контура 

текста на скане. В процессе этой обработки программа автоматически анализирует область внутри 

резаков, находит контур текста, и обрезает по нему. Попутно к скану применяются Despeckle, 

Deskew и т.п. Получается т.н. "голый текст", без полей. Далее рассчитываются средние ширина и 

высота голых текстов (и заносятся в поля Page width и Page height на вкладке Book), создаѐтся пус-

той шаблон с этими размерами, каждый голый текст копируется на копию этого шаблона (с относи-

тельным выравниванием, задаваемым в полях ввода Page h.align и Page v.align на вкладке Pages), а 

затем к этой копии добавляются поля заданного размера (размеры берутся из полей ввода H.Gap 

value и V.Gap value на вкладке Book). Так и получаются конечные обработанные сканы. 

Кроме того, кнопка Process! служит для запуска более простых обработок, задание для которых 

составляет пользователь, выставляя свои опции в программе. 

3.4 Как работают резаки 

Резаки имеют 2 состояния - синий режим и малиновый режим. Резаки - это всего лишь подсказ-

ка для работы обработки по кнопке Process!. Важно понимать, что синий резак - не режет, он лишь 

очерчивает зону, внутри которой обработка по кнопке Process! будет полностью автоматически ис-

кать контур текста - и по нему реально и отрежет. В случае синего резака линия реального разреза 

будет где-то внутри (зоны, очерченной синими резаками) и она будет параллельно данному синему 

резаку (но есть исключение - синие Split-резаки Set internal margin и Set internal margin or split line не меняют никогда 

свой цвет и всегда режут скан по тому месту, над которым находятся - т.к. при разрезании сканов пополам никакое зо-

нальное распознавание не требуется). 

ВАЖНО: Между синим резаком и соответствующей стороной контура текста (по которой и бу-

дет реально отрезано) может находиться произвольное количество белого пространства - это никак 

не влияет на правильную работу обработки по кнопке Process!. Важно лишь, чтобы там было как 

можно меньше грязи - иначе она будет принята Process!'ом за полезный текст, что приведѐт к ненуж-

ному увеличению средних ширины и высоты голых текстов. 

Иногда Draft kromsate автоматически отключает некоторые синие резаки - это означает, что 



Draft kromsate счѐл, что с данной стороны текста никакой грязи нет и резак как подсказка не нужен. 

Однако, это не всегда так - в этом случае нужно вручную включить нужный синий резак (установкой 

соответствующей галки на панели управления резаками) и вручную выставить его. 

Однако, полностью автоматическое (алгоритмическое) определение контура текста невозможно 

в принципе. Поэтому было введено понятие "малиновый резак". Малиновый резак - это "настоящий" 

резак, т.е. он режет скан именно по тому месту, над которым находится (только потом ещѐ к скану 

тоже поля навешиваюся). Малиновый резак - это средство ручной корректировки работы обработки 

по кнопке Process!. 

Наиболее типичное применение малинового резака - это борьба с некорректным отрезанием 

ОВ-символов ("одиночные выступающие символы") - отстоящих далеко от основного текста номеров 

страниц, параграфов, кусочков строк и т.п. - которые программе трудно опознать как смысловые 

элементы - для этого потребовалось бы проводить полноценный OCR (т.е. распознавание текста). 

4 Version 5.93 Что нового   

-  Унифицированы  диалоги  импорта pdf и djvu. Добавлена  возможность  импорта  

произвольного набора страниц. Например 2-10,15-20,66-. Если после последнего тире не  

стоит номер, то он считается равным последнему номеру страницы в файле   

- Улучшен импорт pdf   

-  Добавлен  фильтр Smart blur (окошко Gray enhance). Предусмотрено  три  вида  силы размы-

тия.  Самый  безопасный – Low. Для  фильтра  задается: Radius (чем  больше,  тем сильнее размытие), 

Threshold – контролирует защиту от размытия контуров букв, Passes – количество  проходов.  Задает-

ся  также  место  применения  фильтра:  перед  чисткой  фона, после чистки фона, перед фильтром 

sharpen из закладки Quality.  

Фильтр следует применять с осторожностью при наличии букв с тонкими перемычками.    

- В опции picture-зон добавлен фильтр Smart blur   

- При создании pdf можно использовать jpg2000-сжатие. СК использует хоть и demo, но полно-

стью  работоспособную  версию  кодека Kakadu. Кодек  можно  скачать  по  адресу  

http://www.kakadusoftware.com/Executables/Win32.zip  

Из архива потребуются только два файла:   

kdu_compress.exe – поместить  в  любое  место  на  диске,  путь  к  файлу  прописать  в настрой-

ках СК: File->Options->Apps->JPG2000 codec  

kdu_v61R.dll – поместить в папку windows\system32.  

Чтобы СК кодировал серые/цветные сканы в pdf формате JPG2000 (JPX в терминологии Adobe), 

на закладке PDF необходимо включить соответствующую опцию. Опция влияет и на способ кодиро-

вания зон, однако его можно при необходимости изменить для всех или избранных зон. Все внешние 

зоны (т.е. используемые в задании для создания pdf) имеют собственный  переключатель,  задающий  

индивидуальный  формат  кодирования  зоны:  

default (формат  наследуется  из  глобальной  опции  на  закладке PDF), JPG или JPG2000 (коди-

рование  с  потерями), TIF (кодирование  без  потерь).  Степень  сжатия  для JPG и JPG2000 задается 

независимо друг от друга.   

-  Новая  команда  в  меню Service: JPG2000 batch converter. Выполняет  пакетное конвертиро-

вание графических файлов в формат JP2 с использованием кодека Kakadu.   

-  Улучшен draft kromsate: уменьшено  количество  ошибок  при  расстановке  резаков (отреза-

ния номеров страниц, «спотыкания» на линиях таблиц и крупных иллюстраций, а также  на  мусоре  в  

нижней  или  верхней  части  скана).  Автоматическое  определение вертикального  выравнивания  



страницы (при  наличии  достаточных  условий  для  такого определения).   

- Добавлен новый метод бинаризации Auto. Работает хорошо в большинстве случаев. При Auto  

после  обработки  СК  отображает  вычисленное  им  значение  порога.  При необходимости  можно  

переключиться  на  метод Custom, и  подкорректировать  порог, используя вычисленное значение при 

Auto как базис.   

- Новый метод выравнивания освещенности Soft. Метод мягкий, не портит иллюстраций, но  не  

такой  чистящий,  как Normal. Рекомендуется  использовать  метод Normal со значением Strrength=5 

для  страниц  без  иллюстраций  и  метод Soft для  страниц  с картинками.  Метод Normal прекрасно  

удаляет  локальные  неровности,  в  том  числе  и избавляет  от  содержимого,  просвечивающего  с  

обратной  стороны  листа.  Метод Soft такими свойствами не обладает.  

Убран метод Aggressive. В ближайшей версии также будут убраны методы Combo и Smart.  При  

открытии  заданий,  в  которых  использовались  упомянутые  методы,  они  будут автоматически 

заменены на Normal, т.к. их действие практически идентично.   

-  В File->Options->Processing новая  опция Crop page content at finalization stage. При включен-

ной  опции  на  стадии  финализации  контур  страниц  обрезается  по  текущим размерам  с  неболь-

шим  запасом.  Запас  задается  в  поле safe gap (в  относительных единицах).  КРАЙНЕ  НЕ  

РЕКОМЕНДУЕТСЯ  включать  опцию Crop page!!! Это  может привести хоть и к незначительным, 

но обрезаниям части букв!   

- Новый метод despeckle – Safe50. Это вариация метода safe. Такой же безопасный как и safe, но 

кластеры букв чистит несколько лучше. Рекомендуется для плохо-пропечатанных сканов,  а  также  

при  наличии  букв  с  тонкими  перемычками  и  разрывами  всегда использовать  метод Safe50. Ме-

тод  можно  задать  как  глобально  для  всей  книги (на закладке  опций Options), так  и  выборочно  

для  отдельных  страниц (Special на  закладке опций Page).   

- Все типы зон можно вращать мышкой. Для этого необходимо нажать Shift и подвести указа-

тель  мышки  к  любой  вершине  зоны.  Как  только  форма  указателя  сменится  на закругленную  

стрелку,  нужно  нажать  клавишу  мышки  и  движением  производить вращение. Вращение проис-

ходит вокруг точки – геометрического центра зоны. Вращать можно как прямоугольные, так и не-

прямоугольные зоны, как в обычном режиме, так и в режиме редактирования вершин.  

Таким образом, при отпущенном Shift, при указателе вблизи вершины, мышка изменяет поло-

жение вершины зоны (размер зоны), при нажатом Shift – поворачивает зону.   

- Улучшен deskew. Теперь он справляется и со сложными случаями   

- При отключенной опции Split внутренний резак Int1 скрывается (ранее он отображался всегда)   

-  Добавлена  поддержка  перетаскивания  файлов  в  окно SK. Можно  перетаскивать графиче-

ские файлы, файл задания skt (только один), а также pdf и djvu. Перетаскивание файлов сразу не-

скольких форматов не допускается, напр., если в перетаскиваемом списке  помимо изображений есть 

pdf- или djvu-файлы, то он будет проигнорирован.   

- Если SK в процессе работы находится свернутым в tray, то его иконка будет менять свой вид:  

а)  по  окончании  обработки,  б)  если  требуется  вмешательство  пользователя (напр., при ошибке). 

Окно СК сворачивается в tray, если в Options включена опция Minimize app to tray. Если  опция  вы-

ключена,  окно  сворачивается  в  панель  задач.  В  этом  случае  по окончании обработки, либо в 

случае ошибки, заголовок окна будет мигать.   

- Опция драфта Safe Top/Bottom теперь сохраняется в ini-файл.   

- Ликвидирована зависимость от dll. Теперь они больше не нужны   

- Закладка опций Convert переименована в Binarization   



- В профили добавлены опции создания PDF   

- Для JPG и JPG2000 файлов в основном окне СК в информационной панели отображается исполь-

зуемая цветовая схема (RGB/GRAY/CMYK/YcbCr/YCbCrK)   
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